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Legendă abrevieri: 

 

A 

Add-In  este un set de componente de programare care adaugă abilități specifice unei 
  aplicații mai mari.  

M 

MS Word M icrosoft Word  

O 

OMS  Output Management System  

Q 

QTAFI  Questions - Tables - Figures 

S 

SPSS   Statistics  

T 

TBCleaner Table Cleaner 
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Ghid 
Acest ghid conține pașii necesari pentru crearea unui set de tabele: 

1. Pregătirea calculatorului și instalarea programelor SPSS și QTAFI. 
2. Modificarea variabilei de analiză în sintaxa OMS. 
3. Crearea tabelelor în SPSS și exportarea lor într-un format editabil (de ex. txt). 
4. Curățarea tabelelor cu TBCleaner și exportarea lor în format .doc. 
5. Formatarea tabelelor cu ajutorul QTAFI, un extensiei Add-In pentru MS Word. 

 

 

Conținut 

 

Crearea seturilor de tabele cu SPSS ....................................................................................... 1 

1. Instalarea programelor ........................................................................................................ 4 

1.1 SPSS ................................................................................................................................. 4 

1.2 QTAFI 8.0 pentru MS Word 2003 / 2007 / 2010 ............................................................. 4 

1.3 Table Cleaner (TBCleaner) .............................................................................................. 7 

2. SPSS ���� Modificarea sintaxei OMS .................................................................................... 8 

2.1 Deschiderea sintaxei OMS ............................................................................................... 8 

2.3  Modificarea sintaxei OMS ............................................................................................... 9 

3. Crearea tabelelor și exportarea lor într-un fi șier editabil .............................................. 12 

4. Curățarea tabelelor cu TBCleaner (TBCLEANER.exe) ................................................ 12 

5. Formatarea tabelelor cu QTAFI ....................................................................................... 14 

6. Finalizarea setului de tabele .............................................................................................. 16 

6.1 Pagina de titlu ................................................................................................................. 16 

6.2 Legenda .......................................................................................................................... 16 

Vă dorim mult succes! ............................................................................................................ 16 

 



4 

 

1. Instalarea programelor 

Propunem ca toate programele care urmează a fi folosite, să fie instalate în prealabil pe 
calculatorul D-voastră. Vă rugăm să verificați versiunile pe care le aveți și să le actualizați 
dacă este posibil.  

 

1.1 SPSS 

Ar fi de preferat să folosiți SPSS 19 cu o licență premium. Alte versiuni de SPSS (până la 
SPSS 14 inclusiv) cu licențe premium funcționează de asemenea. Alte licențe (de ex. 
academic) nu conțin comanda TABLES. 

În versiunea SPSS 12 funcționează și în versiune trial sau cu licență academică, toate 
comenzile de care avem nevoie pentru crearea tabelelor.  

Versiuni mai vechi decât SPSS 12 (de ex. SPSS 11) nu recunosc comeanda OMS. Ca urmare 
nu vor exporta tabelele într-un fișier editabil. 

 

1.2 QTAFI 8.0 pentru MS Word 2003 / 2007 / 2010 

1.2.1 Pregătiți calculatorul pentru instalarea QTAFI.doc:  

a) Deschideți un document MS Word.  
b) Schimbați setările de securitate 

i. în MS WORD 2007 / 2010:  
Word Options -> Trust Center -> Trust Center Settings  
-> Macro Settings selectați "Enable all macros" 
-> Developer Macro Settings bifați "Trust Access to the VBA project object 
model"  

ii.  în MS WORD 2003: 
 Tools -> Macro -> Security  
 -> Macro Security selectați "Low" 
 -> Trusted Sources bifați "Trust Access to Visual Basic Project" 

c) Închideți documentul MS Word. 

1.2.2 Instalați macro-ul QTAFI . DOC 

Urmați următorii pași pentru a instala macro-ul: 

a) Deschideți fi șierul QTAFI . doc 
b) Apasați butonul "Install QTAFI" . 
c) Când apare fereastra "Password was set", apasați "OK" . 
d) Așteptați până apare fereastra "QTAFI has been successfully installed". 

De asemenea puteți urma pașii descriși în limba engleză direct în fișierul QTAFI.doc. 
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În cazul în care la apasarea butonului "Install QTAFI" nu se întampla 
nimic, verificați setările Firewall ale calculatorului D-voastră respectiv 
setările macro ale MS Word (vezi 1.2.1 b.) 

 

 

Programele antivirus pot bloca instalarea macro-ului. Dacă nu 
funcționează instalarea, dezactivați programul antivirus si mai încercați 
odata. 

 

 

Este posibil sa aveți nevoie de drepturi de administrator pentru a modifica 
setarea NORMAL.DOT al MS Word!  

 

1.2.3 Copiați stilurile  

a) Deschideți un set de tabele pe care l-ați primit de la noi sau pe care l-am creat 
împreună în timpul atelierului de lucru. 

b) Deschideți fereastra de editare a stilurilor: 
în MS WORD 2007 / 2010:  
Home -> Styles -> Show the style window -> Manage Styles 
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c) În fereastra nou deschisă apăsați Import/Export și se deschide fereastra de organizare a 
stilurilor. 

      
 

 

d) În fereastra de organizare a stilurilor se selectează stilurile din stânga (stilurile găsite în 
documentul cu tabele) și prin apăsarea butonului "Copy ->" se copiază în "Normal".  

 
 

e) Apăsați "Close"  și închideți documentul MS Word. 

Copierea stilurilor în "Normal" se face o singură dată, imediat după instalarea QTAFI. Astfel 
când se va porni QTAFI în vederea formatării tabelelor, nu mai este necesară crearea stilurilor 
în QTAFI prin comanda "Create all styles". 
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1.2.4 Porniți QTAFI 

i. MS Word 2007 / 2010: în meniu apare comanda: Add-Ins  

 Apăsați simbolul roșu T, pentru a porni QTAFI. 

 

ii.  MS Word 2003: simbolul roșu T apare direct în meniul original. Apăsați-l pentru a 

porni QTAFI. 

 

1.3 Table Cleaner (TBCleaner) 

Fișierul executabil "TBCLEANER.exe" nu necesită instalare prealabilă. Acesta se pornește 
prin dublu-click. 
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2. SPSS ���� Modificarea sintaxei OMS 

În cazul în care doriți să creați seturi de tabele folosind variabile de analiză diferite, cu 
ajutorul programului SPSS, va trebui să modificați variabila de analiză în sintaxa OMS. 

Pentru crearea seturilor de tabele, se folosesc DOUĂ sintaxe SPSS:  

1. TB_sintax.sps - sintaxa care conține comenzile TABLES și analizele statistice pentru 
fiecare întrebare în funcție de variabila de analiză standard BREAK1 . Această sintaxă 
nu necesită schimbări, doar în cazul în care s-a modificat ceva în setul de date 
(variabile, etc.) 

2. OMS_sintax_variabila_analiza.sps - sintaxa care conține definiția variabilei de 
analiză BREAK1 , setările pentru formatarea tabelelor și exportarea unui fișier editabil 
cu tabelele (aici în format text, care necesită prelucrări ulterioare) și comanda de 
includere a sintaxei TB_sintax.sps 

2.1 Deschiderea sintaxei OMS 

Deschideți sintaxa OMS 

i. prin dublu-click sau 
ii.  prin clik-dreapta pe numele sintaxei: Deschide cu / Open with -> SPSS sau 
iii.  din SPSS: File -> Open -> Syntax -> căutați sintaxa in directorul cu materiale de 

la atelierul de lucru. 

Sintaxa OMS se deschide întro fereastră "SPSS Statistic Syntax-Editor" și conține toate 
comenzile importante pentru rularea sintaxei și crearea unui set de tabele, după cum urmează: 

1. Deschiderea setului de date (dacă nu l-ați deschis încă) 
2. Definirea variabilei de analiză BREAK1 

a. Alegerea variabilei de analiză 
b. Definirea valorilor lipsă (missing values) 
c. Recodificarea valorilor în categorii noi 
d. Denumirea variabilei BREAK1 (variable labels) 
e. Denumirea valorilor pentru BREAK1 (value labels) 

3. Definirea formatelor pentru tabele 
4. Comanda OMS 

a. Selectarea tabelelor si titlurilor din Output-ul SPSS 
b. Definirea formatului fișierului nou creat (aici text) 
c. Definirea căii de salvare (director + folder) și a numelui fișierului nou creat (cu 

extensie - aici .txt) 
d. Definirea comenzilor de urmărit în sintaxa TB_sintax  
e. Definirea fișierului care să fie inclus în analiză: TB_sintax.sps 
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2.3  Modificarea sintaxei OMS 

1. Modifica ți numele fișierului  care conține setul de date și calea de acces, după 
modelul: director:\folder\folder\setul_de_date.sav 
de ex. GET FILE = "E:\APM\Universitatea XYZ\set_de_date_uni_xzy.sav". 

 
 

2. Definiți variabila de analiză BREAK1 
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a. Alegeți variabila de analiză 

Variabilele de analiză se stabilesc în funcție de întrebările de cercetare care se 
urmaresc. În exemplul de față variabila de analiză este domeniul de studii de 
referință R8_REF_D. Această variabilă a fost formată în prealabil pe baza 
programului de studii de referință completat de către absolventi. 

 

Când se alege o variabilă de analiză e important ca fiecare categorie să conțină 
suficiente înregistrări. Pentru asta înainte de a stabili variabila de analiză, se 
calculează frecvențele pentru această variabilă: FREQUENCIES variabilă . 

Daca o categorie conține puține cazuri, anonimatul răspunsurilor nu mai este 
garantat! Tabele cu mai putin de 10 înregistrări per categorie ar fi indicat să nu 
fie inlcuse în setul de tabele sau făcute publice. 

b. Definiți valorile lipsă (missing values) 

Se definesc valorile "-9" ca valori lipsă. 

c. Recodificați valorile în categorii noi 

Dacă variabila care se folosește pentru analiză conține prea multe categorii, 
acestea se recodifică în mai puține categorii. În exemplul de față cele 15 domenii 
de studii fundamentale au fost recodificate în 10 domenii de studii. 

d. Denumiți variabila BREAK1 (variable labels) 

Se definește denumirea variabilei de analiză, însa variabila nu primește un nume, 
deoarece acesta nu se folosește în tabele. 

e. Denumiți valorile pentru BREAK1 (value labels) 

Se denumesc categoriile nou formate. Pentru ca aceste nume vor apărea în capul 
de tabel, este indicat să se folosească nume foarte scurte, chiar acronime. Setului 
de tabele i se poate adăuga o pagină care să conțină legenda acronimelor folosite. 
 

3. Definirea formatelor pentru tabele 
Formatele tabelelor ramân neschimbate. 
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4. Comanda OMS 
Cu ajutorul comenzii OMS se prelucrează tabelele care sunt generate în Output-ul 
SPSS. Aceasta contine următorii pași care, după modificările necesare, vor fi efectuați 
automat: 

a) Selectarea tabelelor si titlurilor din Output-ul SPSS 

- nu necesită modificări 

b) Definirea formatului fișierului nou creat (aici text) 
- nu necesită modificări, în cazul în care creați seturi de tabele urmând acest ghid, și 
prelucrând fișierul text ulterior cu TBCleaner și QTAFI.  

c) Definirea căii de salvare și a numelui fișierului nou creat (cu extensie - aici .txt) 

Salvarea are loc cu ajutorul comenzii "outfile" . Este important să fie definită calea de 
salvare și atribuit un nume fișierului care va fi exportat. 

d) Definirea comenzilor de urmărit în sintaxa TB_sintax.sps  

- nu necesită modificări 

e) Definirea fișierului care să fie inclus în analiză: TB_sintax.sps 

Cu ajutorul comenzii INCLUDE se asociază sintaxa TB_sintax.sps, care conține 
comenzile de creare a tabelelor pentru fiecare variabilă (vezi 2. SPSS - Modificarea 
sintaxei OMS). Și în acest pas este important să fie definită calea de acces a fișierului 
și numele acestuia. 

 

 

 

În sintaxa OMS este important ca variabila de analiză să se numească 
mereu BREAK1. Dacă se dorește modificarea sintaxei OMS pentru mai 
multe variabile de analiză, se crează câte o sintaxă OMS pentru fiecare 
variabil ă separat și se salvează sub alt nume. În fiecare dintre aceste 
sintaxe diferite, se modifică doar partea de definire a variabilei BREAK1, 
și denumirea fișierului care va fi exportat. 
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3. Crearea tabelelor și exportarea lor într-un fi șier editabil 

După ce ați introdus toate modificările necesare în sintaxa OMS, puteți să o rulați. Pentru asta 
puteți urma următorii pa și: 

a) Deschideți sintaxa OMS (în cazul în care ați închis-o între timp) 
b) Selectați întregul text (ctrl A) și rulați-l (ctrl R) sau din meniu apasați "Run"  -> "All"  

Crearea tabelelor în output-ul SPSS ar trebui să dureze câteva secunde sau minute, în funcție 
de mărimea setului de date.  

Rezultatul este un fișier text (.txt), care s-a salvat în directorul de lucru. Acest fișier necesită 
prelucrări adiționale de curățare și formatare, explicate mai jos. 

 

4. Curățarea tabelelor cu TBCleaner (TBCLEANER.exe) 

TBCleaner adaugă unele tag-uri de formatare fișierului text (de ex. linii și capuri de tabel), de 
care macro-ul QTAFI are nevoie pentru a formata tabelele corect. 

Pentru a continua prelucrarea fișierului text creat cu ajutorul sintaxei OMS, va trebui întâi să 
deschideți fi șierul TBCLEANER.exe.  

 
TBCleaner trebuie să se afle în aceeași director de lucru cu fișierul text 
(.txt) care va fi importat pentru curățare. De preferat ar fi ca acestea să fie 
copiate pe o partiție locală a calculatorului.  

Daca rulați TBCleaner de pe un stick de memorie, sa vă asigurați ca 
acestea se află întro director și nu pe rădăcina stick-ului. 

În cazul eventualelor erori de execuție, apăsați OK sau RUN. 

În pasul următor apăsați butonul "Select Input File". 
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Căutați în directorul în care lucrați, fișierul text pe care tocmai l-ați creat 
("TB_variabila_analiza.txt") și apăsați "open". 

 
În câmpul "path"  trebuie sa fie introdusă automat calea directorului de 
lucru în care se află TBCleaner-ul și fi șierul text. Dacă după importarea 
fișierului text, calea dispare, încercați să copiați TBCleaner-ul și fi șierul 
text într-un alt director, de preferin ță pe o partișie locală a calculatorului 
pe care lucrați. 

Apăsați "Start".  
 

 
 
Programul Table Cleaner crează acum un document Word și îl salvează în același director de 
lucru sub numele: TB_variabila_analiza.DOC 
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5. Formatarea tabelelor cu QTAFI 
 
Documentul Word creat cu ajutorul TBCleaner necesită formatare finală. Pentru asta folosim 
AddIns-ul QTAFI pe care l-am instalat în prealabil (vezi 1.2 QTAFI 8.0 pentru MS Word 
2003 / 2007 / 2010) 
 
Deschideți documentul TB_variabila_analiza.DOC  
Imediat se deschide o fereastră în care se setează codificarea. În cazul în care aceasta nu este 
setată automat pe Unicode (UTF-8), va trebui să o căutați și selectați D-voastră și să închideți 
fereastra prin apăsarea butonului "OK ". 
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Odată ce s-a deschis documentul, deschideți QTAFI prin apăsarea simbolului roșu T. 

În fereastra care s-a deschis trebuie efectuate următoarele setări: 
  
 "Admin " ->  Setați directorul de lucru (Work directory). Pentru asta e nevoie sa 
   apăsați butonul work directory și să căutați directorul de lucru (cel care 
   conține și celelate documente și fi șiere). Apoi apăsați Cancel și "Save 
   your settings" 
  
 "1 Options" -> Selectați limba germană iar apoi din nou limba engleză. Apoi apăsați 
   "Save your settings" 
 
 "5 Format tables" -> Formatați tabelele prin apăsarea butonului "START: Format of 
    OMS tables". 
    În cazul în care nu ați creat stilurile necesare în timpul instalării 
    QTAFI, atunci va trebui să le creați acum. Pentru asta apăsați 
    butonul "Create all styles". Butonul rămâne apăsat pentru 
    câteva secunde. După ce a revenit puteți formata tabelele prin 
    apăsarea butonului "START: Format of OMS tables". 
 

 
 
În urma formatării, vi se va cere să salvați documentul formatat, fie sub acelasi nume, fie să-l 
redenumiți.  

1 2 3 

1 2 

2 

1 

3 

4 

4 

4 
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6. Finalizarea setului de tabele 

Setul de tabele formatat se poate folosi acum pentru diseminarea și publicarea rezultatelor. 
Înainte însă de a-l face public e nevoie să mai adăugați o pagină de titlu și o pagină care să 
conțină o legendă a acronimelor folosite (după caz). 

6.1 Pagina de titlu 

Pagina de titlu va trebui să conțină urmatoarele informații: 

Titulul studiului 

Set de tabele în funcție de "variabila de analiză"  

Promoția xxxx 

Data: yy.ll.aaaa 

 

Autori:  

Numele autorului / autorilor 

E-mail: adresa de email a autorului / autorilor 

 

Instituția de proveniență a autorului / autorilor 

 

6.2 Legenda 

Legenda 

"Variabila de analiză" 

Acronim Denumire 

Acr 1 Denumire 1 

Acr 2 Denumire 2 

Acr 3 Denumire 3 

Total Total 

Cuvintele scriese in culoare roșie sunt cele care vor trebui adaptate setului D-voastră de 
tabele. 

 

Vă dorim mult succes! 


